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1. General information 

These operating instructions are included with delivery. 
 
 

 
 

Devices may only be installed by specialist road traffic installation personnel. Installation must 

comply with all applicable regulations and guidelines. 

In the interest of further development, we reserve the right to change individual assemblies and 

accessories as considered necessary for further safety and performance improvements, while 

preserving the main features. The copyright to these instructions remains with Langmatz GmbH. 
 

 

2. Safety information 
• Only operate the Crossguide on road traffic signal systems that meet Class X1 criteria in 

accordance with DIN EN 50556:2018. At least one of the following classes must be 
complied with in accordance with DIN EN 12675:2017: Class AA1; Class AD1. 

• fDo not use the product if it is damaged. Please contact the hotline (see "Contacts"). 
• The operating company is responsible for installing, operating and maintaining the fixtures. 

 

 

• Devices may only be opened by specialist personnel. Before opening a device, ensure that 
it is disconnected from the operating voltage. Operating an open housing carries a risk of 
contact with live components or conductors and/or conductor paths. Looking directly at the 
LEDs can impair your vision. 

• Observe the technical data provided (see Section 4). 
 

3. Scope of delivery 
 

1 x EK 533 plus 2.0 pedestrian signal requesting device for the visually impaired with  

     connection cable    

2 x M6 x 25 (A2) fastening screws  

1 x Crossing symbol accessories kit 

      Contents: 4 x (see Fig. 19) 

1 x Universal lighting-pole adaptor for poles with a diameter of 89 - 159 mm 

1 x silicone pole seal  

1 x Special key 

1 x Drilling template (self-adhesive paper) (see Fig. 13) 

1 x operating instructions  

1 x Relief symbol accessories set, including two blank covers 

CAUTION! Any person operating, maintaining or repairing the device must have read 

and understood these operating instructions, and must observe them at all times. 

We cannot accept any liability for damage and malfunctions caused by a failure to 
observe the operating instructions. 

Danger! 

Applicable occupational safety and environmental protection regulations must be 

observed during assembly, operation, care, maintenance and repair. 
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4. Technical data 

Designation EK 533 plus 2.0 pedestrian signal requesting 
device for the visually impaired 

Operating voltage 24 - 40 V AC/DC   |   24 - 230 V AC                            

must be set in cgManager 

(see Page 45, Fig. 66). 

Housing colour Yellow, similar to RAL 1023, solid coloured 

STANDARD, other colours available upon 

request. 

Housing material Polycarbonate, PC 

Protection class II 

Protection rating IP54 

Safety SIL 2 

Power consumption Typically 7 W | Maximum 13 W  

Mounting 2 x A2/M6 x 25 hexagon socket screws 

Lighting-pole adaptor Universal, stainless steel, 

suitable for a diameter of 89 mm, 108 mm and 159 

mm Optionally available: Lighting-pole adaptor > 

diameter 159 mm and wall installation 

Operating temperature -25 °C to +60 °C 

H/W/D 256 mm/107 mm/68 mm (distance from pole) 

Acoustic frequency range 180 - 17,000 Hz 

Release signal (RS) clock 

frequency as per DIN 

32981:2015-10 

Default settings: 1 Hz; 4 Hz and 6 Hz 

(dependent on traffic noise); 

Customised settings possible 

 

Acoustic volume at a distance of 

1 m as per DIN 32981:2015-10 

 

Dependent on traffic noise, min. 35 dB(A) to max. 

90 dB(A); in combination with a remote speaker 

Customised settings possible 

Acoustic sounds Freely selectable; new sounds can be uploaded to the 

device, (wave) voice output possible 

Parameter adjustment Via USB cable, via serial cable or via Bluetooth 

Device satisfies the following standards  DIN VDE 0832-100, 200 EN 50293:2000 

 DIN 32981:2015-10 

  ÖNORM V2100, V2101 

4.1 Dimensions 
 
 
 
 
 
 

 

256 
 

 
68 

107 
Fig. 1 Fig. 2 

Orientation signal (OS) clock 
frequency 
as per DIN 32981:2015-10 

Default settings: 1.2 Hz (dependent on traffic noise); 
Customised settings possible 
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4.2 Supply inputs 
 
 

Designation Core Minimum Maximum Unit 

     

Permanent operating voltage 2    

Pedestrian GREEN/Release (optional) 1    

Input voltage range per input 

 

 

 
0.8 U 

Nom  
  (min. 20 V) 

 
 

1.2 U 
Nom 
 

 (max. 253 V) 
 

volts 

 

Input power  2.2 13 watts 

Nominal voltage 24 - 40 AC/DC | 230 V AC 

Colour background represents core colours. 
 

4.3 Optional control inputs 
 
 

Optical feedback 4    

Optional control inputs 1, 2, 3 16, 15, 14    

 
Input voltage per input 

  
0.8 U 

Nom 
 

  (min. 20 V)  
 

 
1.2 U 

Nom 
 

 (max. 253 V)  

 

volts  

 

Input power per input  0.4 

 

0.7 watts 

Nominal voltage 24 - 40 AC/DC | 230 V AC 

Functions e.g. 
Night-time reduction/tone shut-off, activation of 

special signal 

Colour background represents core colours. 
 

4.4 Switching outputs 1+2+3 

(Relays can be parametrised, are potential-free and maintenance-free) 
 

Switching voltage 1-250 V AC/DC 

Switching current  1 100 mA 

R 
on 

 4 8 ohms (Ω) 

Optional switching outputs 1, 2, 3 
6/7, 8/10, 

11/12 
Potential-free switching output 

Contact types Turnkey/N. Closed 

Switching pulse length Can be parametrised between 100 ms and 5000 
ms  

 

4.5 Requesting a signal 
 

Large-surface push-button (optional) 
Via potential-free switching outputs 1, 2 or 3 

(can be parametrised) 

Large-surface sensor (optional) 
Via potential-free switching outputs 1, 2 or 3 
(can be parametrised) 

Vibrator push-button 
Via potential-free switching outputs 1, 2 or 3 

(can be parametrised) 

Contact types Turnkey/N. Closed 

Switching pulse length Can be parametrised between 100 ms and 5000 ms 
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4.6. Block diagram 
 
 
 
 
 

 
 
 
 

Fig. 3 
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  4.7 Return conductor options 

 
In the delivery state, all functions are operated via a return conductor (neutral conductor) (case 1). 
In certain cases, e.g. in the event of mixed voltages or monitored signal cables, the corresponding 

return conductors can be disconnected if required. 
 
 

The following functions can be disconnected: 
 
- Green signalling 

- Optical feedback 
- Supply voltage with optional control inputs 
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5. Operating modes 

The EK 533 plus 2.0 pedestrian signal requesting device for the visually impaired has several 
operating modes, allowing it to be used as flexibly as possible. 

The relevant operating voltage must be selected in cgManager (see Fig. 66). Jumper position 

(see Fig. 9). 

 
Each mode has requirements for: 

• Connecting the device to the control unit 

• Software parameters 

• Device hardware modifications (buffer PCB) 
 
 
 

• When the operating voltage is 

applied, the device is in initialisation 

mode. 

 
• The current operating mode is 

displayed after the green signal is 

activated for the first time. 
 
 
 
 
 
 

 
Operating mode Jumper 

connected 

Goldcap 

buffer PCB 

Parametrisatio

n required 

Notes 

P mode - - -  

PR mode - - OPT3 = Red signal 1 

PRF mode - - FRS active, 

OPT3 = Red 

signal 

1; 2 

RG mode Yes - - 1 

RGF mode Yes Yes FRS active 1; 2 
 

1 Should not be used in Germany  

2 Flashing mode does not conform to DIN 32981 

 
 
 

 

Once the device is switched on, the operating voltage must be defined in cgManager. The device 

is internally ready for operation. When the device detects overvoltage/undervoltage, it switches off 

all tactile and acoustic signals. The device cannot be damaged by applying a higher/lower voltage 

than the one in the settings. (See Page 42, Fig. 66.) 
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5.1  P mode (permanent voltage supply) 
 

Connection  

• Supply: Permanent 

voltage 

 
• Software 

parameters: None 
 
 
 
 
 
 
 
 
 

 

Fig. 4 

 
 

Description: 

The green release is signalled via a separate voltage. Traffic light red status is not signalled to the 

device. 

The jumper, which activates the device supply via the green pedestrian signal, is not connected. 
 
 
 

 

5.2  PR mode (like P mode but with red input as well) 
 

Connection  
• Supply: Permanent 

voltage 

 
• Software parameters: 

Function of optional input = Red signal 

(see Fig. 65) 
 
 
 
 
 
 
 
 

 

Fig. 5 

 

 

Description: 

Traffic light red status is signalled to the device via an additional input. 

The jumper, which activates the device supply via the green pedestrian signal, is not connected. 

Erroneous red/green signals are detected and switch off the device. 

If there is no signal, no orientation signal will sound. The device requires a signal on optional input 

3. This status is detected but not signalled. 
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5.3 PRF mode (like PR mode but with an additional flashing option for green) 

 
Connection 

 

• Supply: Permanent 

voltage 

 
• Software parameters: 

Release green flashing: 

active 

 
Function 

of optional input 3 = Red signal 

(see Fig. 65) 
 
 
 

 

Fig. 6 

 

Description: 

Traffic light red status is signalled to the device via an additional input. The jumper, which 

activates the device supply via the green pedestrian signal, is not connected. Erroneous 

red/green signals are detected and switch off the device. Flashing mode is also activated by 

device parametrisation. Using a special flashing release signal (FRS), this mode enables acoustic 

notification that the green phase is coming to an end: 
 

 

Signal progression 
 

 
 

Fig. 7 
 

Detection: 

The FRS is only activated if there is a green signal for at least two seconds. The status "Green 

flashing" is detected by a trailing edge on the green signal. If there is another pulse within 700 ms, 

the device continues flashing green. If there is no further pulse, signalling switches off. The FRS is 

also switched off by a red signal. 

 
In PRF mode, the lack of a red or green signal is detected as sleep mode. This status is detected 

but not signalled. 
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5.4 RG mode (power supply via red and green cables) 
 

Connection  

• Supply: 

Via red/green alternately 

 
• Software 

parameters: None 
 
 
 
 
 
 
 
 
 
 

Fig. 8 

 

 

Description: 

 
The jumper, which activates the device 

supply via the green pedestrian signal, is 

connected. Erroneous red/green signals 

are detected and cause the device to shut 

off. 
 
 
 
 
 
 
 
 

 

Fig. 9 

Jumper on 
terminals 21 + 22  
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5.5  RGF mode (like RG mode but with an additional flashing option for green) 
 

Connection  

• Supply: 

Via red/green alternately 

 
• Software parameters: 

Release green flashing: 

active 
 
 
 
 
 
 
 
 
 
 

Fig. 10 

 

Description: 

The jumper, which activates the device supply via the green pedestrian signal, is connected 

(Fig. 9). Erroneous red/green signals are detected and switch off the device. Flashing mode is also 

activated by device parametrisation. Using a special flashing release signal (FRS), this mode 

enables acoustic notification that the green phase is coming to an end: 
 
 
 

 

Signal progression 
 

 
 

Fig. 11 

 

 

Detection: 

The FRS is only activated if there is a green signal for at least 2 seconds. The status "Green 

flashing" is detected by a trailing edge on the green signal. 

If there is another pulse within 700 ms, the device continues flashing green. If there is no further 

pulse, signalling switches off. The FRS is also switched off by a red signal. 
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6. Installation 

6.1 Installing the pedestrian signal requesting device for the visually impaired on the pole 
 

 

• Before installing the device on the 

pole, check and ensure that the 

communications interface (1) is freely 

accessible. 

(Check for bulges on the pole). 
 
 
 
 
 
 
 
 
 

Fig. 12 

 
 
 

 

• Remove the protective foil from the 

drilling template supplied. 

• Attach the drilling template at 

operating height in line with the pole 

axis. 

• Mark three holes. 

• Drill 2 holes with a diameter of 5 mm (for 

mounting). 
• Cut 2 x M6 threads. 

• Drill 1 hole with a 16 mm diameter (for the 
cable duct). 

 
 

Fig. 13 Langmatz recommends using a (metal) 

drilling jig. Langmatz item no. 700663003. 

(See also "Accessories"). 
 
 

 

• Loosen SW4 hexagon socket locking 

screws (2) on the pedestrian signal 

requesting device for the visually 

impaired and remove the top part of 

the device (3). 

 
 
 
 
 
 
 
 
 
 

Fig. 14 

 
 
 
 
 
 
 
 
 
 

 

1 

3 

2 2 

Drilling template 

1x 16 mm  
diameter 

2x 5 mm 
diameter / M6  
thread 
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• Disconnect the supply line for the top 

part of the device by releasing the 

connector lock (4). 

• Fasten the bottom part of the device to 

the pole using the pre-installed, 

stainless-steel lighting-pole adaptor 

and flexible pole seal (M6 x 25 A2 

screws supplied). 

• Note: For poles > 159 mm in diameter, 

use the optional lighting-pole adaptor 

for large poles. For wall installation, 

use the appropriate wall adapter. 

• Note: Torque approx. 5 Nm. 

• Note: The flexible silicone pole seal 

must fit correctly between the pole 

and the signal requesting device. 

• Place the captive plastic caps (5) back 

on both M6 

fastening screws. Make sure that the 

device fits correctly (protection 

class!). 

• Connect the connection cable to the 

cable distributor according to the block 

diagram (see Section 4.6). 

• Unused cores must remain 

insulated. 

• After installing the pedestrian signal 

requesting device for the visually 

impaired, a function test must be 

performed: 
 

Green = Release signal  

Red = Orientation sound 

 
You must be able to tell the two 

sounds apart clearly. 

Bottom part of 
device 5 4 

5 

Fig. 15 
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6.2 Aligning the crossing symbol 
 

• The pedestrian signal requesting device 

for the visually impaired is factory-fitted 

with a crossing symbol (6). 

• If the specified direction of the 

crossing symbol does not match the 

direction required, proceed as 

follows: 
 
 
 
 
 
 
 
 
 

Fig. 16 

 
 
 
 

• Open the white brackets (7) with 

the special key supplied (8). 

• Push in the crossing symbol slightly (to 

disengage it) and turn it in the required 

direction. 

• Make sure that the integrated spring 

does not come out. 

• Remove the special key (8). 

• Release the crossing symbol and re-

engage it. 

• Make sure that the integrated silicone 

seal (9) fits correctly. 

 
Fig. 17 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 18 

• Before installing the top part of the 

device (3), you need to install the relief 

symbol inserts (accessories kit) based 

on the circumstances of the crossing 

(see Section 6.3). 

• Reconnect the supply line for 

the top part of the device 

(Fig. 15, 4). 

• After inserting the relief symbols, 

push the top part of the device (3) 

onto the bottom part (10). 
• Check that it fits correctly and securely. 

• Tighten the SW4 hexagon socket 

locking screws (2). 

 
 
 
 
 
 
 
 
 
 
 
 

 
6 

3 

10 

2 2 
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Symbols for the visually impaired as per DIN 32981 and ÖNORM V2100 

 

1 Crossing with an additional request 

2 Crossing only 

3 Crossing with central island 

4 Crossing with level crossing 

5 Crossing in 2 directions 

 
A more detailed description of the 

symbols and their functions is specified 

in DIN 32981. 

 
Fig. 19 

 
 
 
 

6.3 Installing the relief symbols 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 20 

 

Example of relief symbols 

• 

The signage pockets for the relief 

symbol inserts (11) are on the left and 

right of the pedestrian signal 

requesting device for the visually 

impaired. 

• The relief symbol inserts must be 

positioned in accordance with 

ÖNORM V 2100 (Fig. 22). 

• Max. 13 relief symbol inserts are 

used, depending on the type and 

length of the crossing. 

• If not all of them are required, the empty 

spaces must be filled with blank symbol 

inserts. 

 
• Note: All inserts must be correctly 

placed so that they do not present an 

obstruction when fitting the top part of 

the device. 

 

 
• Having completed the whole 

installation, you need to check if the 

relief symbols correspond with the local 

circumstances of the lighting signal 

installation. 

 
• Note: If no relief symbols are desired, 

two blank covers (accessories kit) 

must be placed in the signage pocket. 
 
 
 

 

Fig. 21 

 
 
 
 
 
 
 
 

1 2 3 4 5 

 
 
 
 
 
 

11 

 
 
 
 
 

End 

Two-way cycle path 

Motor vehicle lane 

Motor vehicle lane 

Island with RS request 

Motor vehicle lane 

Motor vehicle lane 

Two-way cycle path 

Start 
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Fig. 22  
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7. Set-up and function test 

7.1 Vibrator and vibrator push-button
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 23 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Fig. 24 

 

• It is essential to check that the 

vibrator push-button (12) is working 

correctly. 

• It must be possible to request a signal in 

every position on the vibrator push-

button. 

• While the signal is enabled, vibration 

on the crossing symbol (13) must be 

clearly palpable. 

• The vibration must not cause 

any kind of humming. 
• If it is necessary to adjust the vibrator, 

proceed as follows: 

 
 
• Remove the top part of the device (3) as 

described in Fig. 14. 

• Loosen the 2 Phillips head screws (14) 

to set the vibration strength. 

• For stronger vibration, reduce the gap 

between the armature and the coil. 

• For weaker vibration, increase the gap 

between the armature and the coil. 

• Check that the vibrator seal fits and refit 

the top part of the device Fig. 18).

 

Optional: 

Requesting a signal with the "LARGE-
SURFACE PUSH-BUTTON" 

 

• Test function by actuating the large-
surface push-button (15). 

 

• There are 2 microswitches integrated 

into the top and bottom sections of 

the large-surface push-button. 
 

 
 
 

Fig. 25 

Requesting a signal with the "SENSOR" 

• Test function by actuating the sensor 

surface (16). 

• The sensor must trigger a signal 

request when the hand is 

approximately 3 mm from the contact 

surface. The sensor cannot be 

adjusted. 

 
 
 
 
 

13 
 

 
12 

 
 
 
 
 
 
 
 
 

 
14 

 
 
 
 
 

15 

16 
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7.2 Optical feedback 
 
 

 
 
 

 
 
 

7.3 Sound test 

• According to the setting, the optical 

feedback (e.g. "Wait for signal") can be 

switched on either by a signal request 

on the EK 533 plus or from the crossing 
control unit. 

 

 

 
• After installing the pedestrian signal 

requesting device for the visually 

impaired, a sound test must be 

conducted. 

 
• The volume setting for the sounds must 

be adjusted to the local surroundings. For 

example, you need to take account of the 

crossing length and adjacent buildings. 

(See Pages 30-31, "Volume" group). 

 
• A release signal must sound on 

green 

• Exception: When switched off by 
cgManager 

 

If one or more of the above functions is not working properly, check the device settings with 

cgManager. 
 

 
 

8. Maintenance 
 
 
• The signal requesting devices must be maintained at regular intervals. When doing so, 

proceed as follows: 

 
• External visual inspection: 

Check the device for external dirt and damage. Note: Do not use abrasive 

cleaning agents or solvents to clean the housing! 

 
• Checking the crossing symbol (6). The correct direction must be set for the crossing 

concerned. 

 
• Carrying out a full function test. If anything on the signal requesting device appears to be 

defective, it must be returned to Langmatz GmbH with a description of the fault. 
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9. Parametrisation 

cgManager (cgManager version 4.17.50.0) 

 

Abbreviations 

PB:  Large-surface push-button S: Large-surface sensor 

VPB: Vibrator push-button RTC:  Real-time clock 

APB: Acknowledgement by push-button  APBI: Acknowledgement by push-button or input 

iAPB: Inverted APB  

APBS: Acknowledgement by push-button and signal system 
 
 

 

cgManager system requirements 

• 1 GHz processor 

• 1 GB RAM 

• Screen resolution 1024 x 768 

 
Supported operating systems: 

• Windows XP SP2 or SP3 

• Windows Vista SP1 or SP2 

• Windows 7 

• Windows 8 

• Windows 10 
 

Installing and starting cgManager 

Note: The person installing the software needs administrator access rights on the 
computer. 

• Insert the installation CD. 

• Start "installer_V4.x.exe" and follow the instructions. 

• After installation, there will be a link to cgManager on the desktop and in the "Langmatz" sub-

menu within the Start menu. This shortcut is used to start the parametrisation software after 

entering the password. 
 
 

 

Establishing a connection with a Langmatz EK 533 plus 2.0 

There are three ways to connect to a Langmatz EK 533 plus using cgManager: 

• A serial cable (CrossCom RS232, item no. 125330996) 

• A USB cable (CrossCom USB, item no. 125330989S) 

• Bluetooth (CrossCom Bluetooth, item no. 125330998) 
 
 

Establishing the connection 

1) CrossCom RS232 

a. Connect the CrossCom RS232 cable to the Langmatz EK  533 plus and an 

available RS232 interface on the PC. 

 
b. Start cgManager. 

If the connected Langmatz EK 533 plus device is switched on, the corresponding COM 

interface is automatically selected and the connection established. If this is not the case, 

the interface must be specified manually (see: "Selecting the interface"). 
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2) CrossCom USB 

 
a. Make sure that cgManager has not started. 

b. Plug the connector into the Langmatz EK 533 plus 2.0. 

c. Connect the USB connection to your PC. 

d. If you are using the cable for the first time on this PC, Windows will now attempt to install 

the USB-to-RS232 driver. If Windows prompts you to specify the path to the driver, insert 

the driver CD and select it. 

e. Once you have completed the driver installation, you can start cgManager. 

f. Select the correct interface. 
 
 
 

Notes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 26 

• Installing the driver may require 

administrator access rights. 

• You can use the Windows Device 

Manager to check which Windows COM 

interface the driver has been assigned 

to. 

• If the USB cable is unplugged while 

cgManager is still active, you will need 

to restart it in order to establish a 

connection. 

• If the USB port on the PC is changed, 

the interface needs to be re-selected 

as it has been assigned a different 

number by Windows. 
 

 

3) CrossCom Bluetooth 

 
a. Make sure that cgManager has not started. 

b. Connect the CrossCom Bluetooth connector to the EK 533 plus 2.0 device. 

c. Connect the CrossCom Bluetooth USB stick (item no. 125330999) to the PC (see notes!).  

d. If the USB stick is being connected to the PC for the first time, Windows will attempt to 

install the appropriate driver. If Windows prompts you to specify the path to the driver, insert 

the driver CD and select it. 

e. Once you have completed the driver installation, you can start cgManager. 

f. Select the correct interface. 

 
Notes 

• Installing the driver may require administrator access rights. 

• Generally speaking, you will not need to install the driver or use the external Bluetooth 

USB stick if the PC already has a Bluetooth module installed. 

• To prevent connection issues, ensure that the PC and the Langmatz EK 533 plus 2.0 

are as close to each other as possible. 

• If your connection is poor, opening the "Parameters" form in cgManager may return 

an error. If this is the case, try reopening the form. 

• Once the "Parameters" form is open, we recommend that you click the "Read" button 

again to prevent synchronisation problems (cgManager - Langmatz EK 533 plus 2.0). 



22  

Selecting the interface 
 

For all three methods, the correct interface must be entered in cgManager. To do this, select 

"Preferences" and then "Interface" or double-click on the interface pane in the status bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 27 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 28 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 29 

• In the open form, select the interface 

you want to use to connect to the 

EK 533 plus 2.0 ("COM X" or 

"Bluetooth"). 

• Close the form by clicking the OK button. 

 

• Alternatively, the button "COM scan" can 
be clicked on. 

 

• This searches for and selects the 

appropriate COM interface. The device 

must be connected to a CrossCom 

RS232 or CrossCom USB in order to 

do this. 

 
Note: As explained above, if you are 

unsure which interface to select, check in 

the Windows Device Manager. 
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• After closing the form, you will see a 

yellow light bulb symbol and the text 

"online". This indicates that you have 

connected successfully. 
 
 
 
 
 

 
Fig. 30 

 
 
 
 

Firmware updates 

 

Updating the Langmatz EK 533 plus 2.0: 

• In the "File" menu, click "Firmware-

Update". 

• In the dialogue box that opens, 

select the file containing the new 

firmware (file ending .EK 533p). 

• Click "Open" and the update will 

start. 
 
 
 

 
Fig. 31 

 

 

Creating and editing sound sequences 
 

• To edit the sounds of an EK 533 
plus 2.0, select "Edit" 

--> "Audio sequences" --> "online". 
• In the open "Audio Sequences (online)" 

form, you can create, edit, play and 
delete sounds (polyphonic sounds and 
wave files). 

 
 
 
 

Fig. 32 

 

 
 

Fig. 33 
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Creating new sounds 
 
 

• You can transmit wave files from the PC 

to the Langmatz EK 533 plus 2.0 or 

define new sounds using the "Signal" -> 

"new" -> "Wave" sub-menu or 

"polyphonic" sub-menu, respectively. 

 

• The new sound is always assigned 

to the signal which is highlighted in 

the table. In the case of Fig. 33 (on 

Page 23), this would be the 

"Release" signal, for example. 

 

 

Fig. 34 

 
 

 

1) Wave files 

 
• Clicking "Signal" -> "new" -> "Wave" opens a selection dialogue box. 

• Here, select the wave file you wish to transmit to the device. 

 
• The system supports 8- and 16-bit wave files. 

 
In theory, the device contains enough memory for approx. 90 seconds of wave files for all signals. 

 
"Audacity" is a recommended program for editing wave files: you can download it for free at 

http://www.audacityteam.org/. 

 
Note: Before wave files are transmitted to the EK 533 plus 2.0, they are filtered based on whether 

they are for release, flashing release or orientation. This is to protect the speakers. Filtering 

sometimes slightly reduces the tone quality of the sound emitted by the device compared with 

playing it on the PC. 

 
Caution: For safety reasons, wave files should not be used for the orientation signal! 

 
 

2) Polyphonic sounds 

 
• Clicking on "Signal" -> "new" -> "polyphonic" opens the sound sequence editor (see Fig. 34). 

• This is where a sound is assigned to a signal type. ("Sequence properties" – "Type") 

• Each line describes a sound which can be used to compile the overall sound. For example, this 

might be a single sound or a base sound with inharmonics. 

 
A sound is always a combination of pulses and pauses. 

 
To define the pulse, set green markers (see Fig. 35 on Page 25) with the last marker defining the 
overall length of the pulse. 

 

http://www.audacityteam.org/
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The other individual parameters are: 

 
a. "Frequency in Hz": Indicates the frequency (pitch) of the sound; permissible 

range: 800 Hz - 5000 Hz. To comply with DIN 32981, the frequency must be 

within a range of 880 Hz +/- 50 Hz. 

b. "Amplitude": Indicates the volume from 0 - 100 

c. "Type": Assigns the sound to a signal (e.g. orientation signal, release signal, etc.) 

d. "Name": Optional name for the sound 

e. "Pause": Pause in ms between two sound pulses 

f. "Increase": The value by which the sound is adjusted relative to the ambient volume. 

 
Example: 

The following (active) sound, and therefore its pulse-pause ratio and 

repetition interval, is defined in Fig. 35: 

• Orientation sound at 880 Hz and an amplitude/volume of 100, no increase relative to the 

ambient volume 

• Tone output (i.e. pulse) of 0 ms to 50 ms, 100 ms to 150 ms and 350 ms to 600 ms (cf. green 

markings) 

• The overall pulse duration is therefore set at 600 ms (see last green marker) 

• Pause of 1000 ms (= 1 s) 

• The overall sound duration (pulse and pause) is therefore 1600 ms (600 ms sound plus 

1000 ms pause) or 1.6 s 

• The repetition interval of the sound is therefore 1/1.6 s = 0.625 Hz at a pulse-pause ratio of 

0.6:1 

 
Once the configuration of a sound is complete for a certain signal type, it can be played 

back as a sample on the PC by clicking on the "Play" button. 

To transmit the finished sound to the Langmatz EK 533 plus, 

complete the process by clicking "Upload to EK 533 plus". 
 

 

 
 

Fig. 35 
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Editing existing sounds 

 
Sounds already present in the Langmatz EK 533 plus 2.0 can be edited in the "Audio Sequences 
(online)" form. 

 
 

 

 
 

Fig. 36 

 

• To do this, mark the desired sound in the 

list by clicking on it and then select 

"Signal" -> "edit". Alternatively, you can 

open the sound for editing by double-

clicking on it. 

• In the opened "Sequence properties" 

form, the properties "Name", "Pause" and 

"Increase" can now be modified. 

 
 
 
 
 

 
 

Fig. 37 
 

Deleting sounds 

 
You can delete sounds from the Langmatz EK 533 plus 2.0 in the "Audio Sequences (online)" form 

by selecting "Signal" -> "delete". You first need to mark the sound you want to delete by clicking 

on it in the table. Alternatively, you can delete a sound with the Delete button. 

 
Playing sounds 

 
You can reproduce existing sounds from the EK 533 plus 2.0 on your PC in the "Audio Sequences 

(online)" form. Mark the desired sound in the list by clicking on it and then click "Play". Clicking 

"Stop" stops playback on the PC. 

 

 
Default sounds 

Default release and orientation sounds can be transmitted to the device without the need to create 

them using the sequence editor. There are up to eight default sounds for each of the two signals, 

each of which can be copied to the EK 533 plus by clicking on button "1a" to "4b" or "1" to "4" 

respectively. 
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Online parametrisation of the Langmatz EK 533 plus 2.0 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 38 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To parametrise a Langmatz EK 533 plus 2.0 

device using cgManager: 

• In the "Edit" menu, click on the "Device 

parameters" entry and then click 

"online". 

 This reads out all EK 533 plus 2.0 

devices and displays them in the 

opened "Device parameters" form. 

• If you edit one or more parameters, this 

will be flagged with a red marker. 

• To transmit the change(s) to the 

Langmatz EK 533 plus 2.0, click "Write". 

The red markers will disappear once the 

parameters have been transmitted. 

• Alternatively, you can select the "Write 

directly" option in the "Preferences" 

menu, which will immediately transmit 

the modified parameters to the device 

so that you need not click "Write". 

 

• Click the "Read" button to read out the 

Langmatz EK 533 plus parameters at 

any time. 
• This will list all parameters along with 

their meaning and setting options.

 

 

"Sounds" tab 

 

In this tab, you can configure the individual 
sounds. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 39 



28  

"General" group  

• This parameter group determines the 

general response of the sound in 

question. 
 
 
 
 
 
 
 
 

 

Fig. 40 

 

Activation – release signal: 

 
Specifies how the release signal is activated. The following options are available: 

• off: The release signal is deactivated and does not play. 

• Green signal: The release signal sounds if the device is displaying the green signal. 

• Network: The release signal sounds if the device is networked and displaying the green signal 

(cf. "Networking", Page 36). 

• PB/S: The release signal sounds if the device is displaying the green signal and the push-

button or sensor is activated during the preceding red or green phase. 

• VPB: The release signal sounds if the device is displaying the green signal and the vibrator 

push-button is activated during the preceding red or green phase. 

• PB/S/VPB: The release signal sounds if the device is displaying the green signal and the push-

button, sensor or vibrator push-button has been activated during the preceding red or green 

phase. 

 
Activation – orientation signal: 

 
Specifies how the orientation signal is activated. The following options are available: 

• off: The orientation signal is deactivated and does not play. 

• Permanent without RS: The orientation signal always sounds, without the need for a red signal. 

When the signal changes to green, the orientation sound stops. 

 

• Permanent with RS: The orientation signal always sounds, without the need for a red signal.  

When the signal changes to green, the orientation sound continues. If there is an active release 

signal, both sounds are played at the same time. 

• Another option for activating the orientation sound is a red function on cable 14 (optional input 

3). As an option, this cable can be used as a red input. Where this is the case, the orientation 

sound only plays when the red input is activated in a red phase. 

• For the appropriate change, see section 

"Special function of optional control input 3" (p. 41) 

 
Activation – special signal: 

 
Specifies how the special signal is activated. The following options are available: 

• off: The special signal is deactivated and does not play. 

• Opt. 1, Opt. 2, Opt. 3: The special signal plays when there is a signal on the specified optional 

input. 
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Activation – acknowledgement signal: 

 
Specifies how the acknowledgement signal is activated. The following options are available: 

• off: The acknowledgement signal is deactivated and does not sound. 

• PB/S: The acknowledgement signal sounds if the large-surface push-button is pressed or the 
large-surface sensor is actuated during the red phase. 

 

• VPB: The acknowledgement signal sounds if the vibrator push-button is 

pressed during the red phase. 

• PB/S/VPB:  The acknowledgement signal sounds if the large-surface push-button, large-surface 

sensor or the vibrator push-button is actuated during the red phase. 

 
Duration (s): 

 
You can use this selection box to specify whether the relevant signal or the vibrator is actuated 
continuously – "cont." (default) – or for 1 to 60 seconds. 

 The activation conditions above still apply. This means, for instance, that to play the orientation 

signal on the "Red signal" setting, the red signal must be present as described and the sound is 

only played for the duration of the signal. If you set a duration of 50 s but the red signal is only 

present for 30 s, then the sound will only play for 30 s as well. 

 
Speakers: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 41 

Specifies which speaker is used for the 

signal output: 

• "external 1": The signal sounds on the 

1st external speaker of the 

EK 533 plus 2.0. 

• "external 2": The signal sounds on the 

2nd external speaker of the 

EK 533 plus 2.0. 

• "both": The signal sounds both on the 

1st external speaker and on the 2nd 

external speaker of the EK 533 plus 2.0. 

 

 
 

• There is an option to add the internal 

speaker to the 2nd external speaker. 

• To do so, switch "S1" is pushed 

downwards (as-delivered condition). 
 
 
 
 
 
 
 
 

 

 

Fig. 42 

 

S1 



30  

Green flashing 
 

Switches green flashing "on" or "off". When the green flashing function is activated, a green 

flashing sound must also be present in the Langmatz EK 533 plus 2.0. (You can check this using 

the "Edit" -> "Audio sequences" -> "online" menu.) 

 

 

 
• RGF mode requires a Goldcap buffer 

PCB.  

This is available as an option or can be 

retrofitted. Item no. 125330825. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 43 

 
 

"Volume" group 

 

This parameter group determines the 

volume and dynamics of the sound in 

question. 
 

 
 
 
 
 
 
 
 
 

 
Fig. 44 

Current max. level (dB) 

• This is purely a display parameter; it 

cannot be changed by the user. It 

indicates the current maximum level 

based on whether any restrictions have 

been set. 

• In daytime mode, the value is always the 

same as that of the "Level max. (dB)" 

parameter. In night-time mode, it is the 

reduced maximum level, which is "Level 

max. (dB)" minus "Level (dB)". 

 

• Example: Night-time reduction active, 

"Level max. (dB)" at 85 and reduction 

"Level (dB)" at 35. This reduces the 

"Level max. current (dB)" to 50, i.e. 85 dB 

reduced by 35 dB. 

 
Level min. (dB) 

• The minimum level sets the lower signal 

volume limit within a range of 30 to 85 dB. 
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The following restrictions apply: 

 
• The minimum level can never be higher than the maximum level. 

• "Level max. (dB)" minus reduction "Level (dB)" can never be lower than "Level min. (dB)". 

Otherwise, this can result in invalid values with night-time reduction active. 

 
Level max. (dB) 

 
• The maximum level sets the upper signal volume limit within a range of 35 to 90 dB. 

 
 

 
The following restrictions apply: 

 
• The maximum level can never be lower than the minimum level. 

• "Level max. (dB)" minus reduction "Level (dB)" can never be lower than "Level min. (dB)". 

Otherwise, this can result in invalid values with night-time reduction active. 

 
Elevation (dB) 

 
• Elevation specifies the dynamic level of the sound above which the sound is audible over 

ambient noise. For example, with an ambient volume of 65 dB and a set elevation of 10 dB, 

the volume of the signal will be 75 dB. 

• Restriction: This value can only be set if the values for "Level min. (dB)" and "Level max. 

(dB)" are different. If they are the same, the sound is static. 

 
Increase (max. dB/s) 

 
• Sets the speed at which the sound follows the level of traffic noise. 

• Restriction: This value can only be set if the values for "Level min. (dB)" and "Level max. (dB)" 

are different. If they are the same, the sound is static. 

 
Decrease (max. dB/s) 

 
• Sets the speed at which the sound decays as traffic noise decreases. 

• Restriction: This value can only be set if the values for "Level min. (dB)" and "Level max. 

(dB)" are different. If they are the same, the sound is static. 
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"Lowering" group 
 

• This parameter group determines the 

night-time reduction of the relevant 

sound, i.e. whether and how much a 

sound’s volume is reduced. 
 
 
 
 
 
 
 

 

Fig. 45 

 
 
 

 

Control 
 

Specifies how the reduction is controlled: 

• "deactivated": No reduction 

• Opt. 1: The sound is reduced using 

optional input 1. 

• Opt. 2: The sound is reduced using 

optional input 2. 

• Opt. 3: The sound is reduced using 

optional input 3. 

• "time controlled": The RTC controls 

the reduction. 
 

 
 

Fig. 46 

Notes 

• If the Langmatz EK 533 plus 2.0 has no 

built-in RTC, this option is not available. 

• Do not use the same optional input for 

the sound for night-time sound reduction 

and (de)activation (e.g. do not use "Opt. 

1" to control the reduction and also 

(de)activation on release signal). 
 
 

 

Level (dB) 
 

• Sets the reduction from 0 to 55 dB. When night-time reduction is active, this value is deducted 

from the maximum level; see "Level max. current (dB)" parameter for the currently applicable 

maximum level. 

• The following restrictions apply: 

This value can only be set if an optional input has been selected for "Input". (In other words, 

"inactive" is not selected here.) 

"Level max. (dB)" minus reduction "Level (dB)" cannot be lower than "Level min. (dB)", 

otherwise an active night-time reduction could result in invalid values. 
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Logic type  
 

• Setting option "low" or "high" based on 

the required logic for the optional input. 

• Restriction: This value can only be set if 

an optional input has been selected for 

"Input". (In other words, "inactive" is not 

selected here.) 

 
 

 

Fig. 47 

 
 

Time  
 

• Selecting the "time controlled" option in 

"Control" on an EK 533 plus with RTC 

allows you to define the period when the 

sound is to be reduced. 
 
 
 
 

Fig. 48 

 

 

"(De)Activation" group  

 

 

 

 
 
 
 
 

Fig. 49 

• This parameter group specifies the additional conditions that may be required to  

play the sound in question. 
 

Control 
 

 

 

 

 

 

 

 

Fig. 50 

Specifies how (de)activation is controlled: 

• "deactivated": No (de)activation 

• Opt. 1: The sound is (de)activated by 

optional input 1. 

• Opt. 2: The sound is (de)activated by 

optional input 2. 

• Opt. 3: The sound is (de)activated by 

optional input 3. 

• "time controlled": The RTC controls 

(de)activation. 
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Notes 

• If the Langmatz EK 533 plus 2.0 has no built-in RTC, this option is not available. 

• Do not use the same optional input for the sound for night-time sound reduction and 

(de)activation (e.g. do not use "Opt. 1" to control the reduction and also (de) activation on 

release signal). 
 
 
 

Mode 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 51 

• This parameter determines whether an 

optional input (selected under "Input") 

activates the signal or deactivates it, e.g. 

for night-time deactivation. In other 

words, you can expressly specify 

whether a signal is switched on or off by 

an optional input. 

• If you select "Activation", the actual 

signal (i.e. red or green) must also be on 

the optional input selected in order to 

produce a sound. 

 

 

Example 1: 

Orientation sound: "Activation" selected under "Mode", "Opt. 1" as an input and "high" under 

"Logic type". The orientation signal will then sound exactly when the red signal is on the EK 533 

and optional input 1 is set to high. 

 

 
 
 

 
 

 
Logic type 

• Setting option "low" or "high" based on 

the required logic for the optional input. 
 
 
 
 
 
 
 
 
 

Fig. 52 
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Time 
 

• Selecting the "time controlled" option in 

"Control" on a Langmatz EK 533 plus 

2.0 fitted with an RTC allows you to 

define the period when the sound is to 

be (de)activated. 

 

 

Fig. 53 

 

 
 
 

"Outputs" tab 

• In this tab, you can configure the switching 
outputs. 

 

 
PB/S (ms) 

• Determines how long a pulse is emitted 

on the output concerned when the large-

surface push-button or large-surface 

sensor has been pressed. 
 

 
 
 
 

Fig. 54 

VPB (ms) 

• Determines how long a pulse is emitted 

on the output concerned when the 

vibrator push-button has been pressed.  

 
 

Logic type 
 

• "Turnkey"/"N. Closed" setting option based 

on the required output logic. 

 
 
 
 
 
 

 
 

 Fig. 55 

 
 
 

Important note: 
 
The release signal must be activated and deactivated in compliance with DIN 32981. 

This is carried out by the control unit of the road traffic signal system. 
If shut-off or reduction is performed by the RTC of the EK533 plus 2.0, the change will only 
become effective during the next green phase.  
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Networking 

 
Switching on the network allows you to connect EK 533 plus 2.0 devices together as shown by 

the diagram. This activates optical feedback not only on the device on which the green signal 
is requested, but also on the device connected to it. It also sounds the release signal on all 

networked devices. This function is required if an installation is retrofitted but the control 
device does not feature signals for the visually impaired. 

 

 

 
Fig. 56 
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Fig. 59 
 
 

• To switch on the network, you need to 

select the relevant release signal 

activation setting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 57 

 
 

• Switching output 3 is used for the 

network. 

• When networked and depending on the 

setting, switching output 3 is activated 

via the large-surface push-button 
-  

- via the large-surface sensor 

- via the large-surface vibrator 

- or via both. 

 
Example: Selecting "VPB" activates optical 

feedback on all networked devices during a 

red phase. The release signal sounds once 

on the next release after red. Therefore, the 

release signal will sound exclusively when a 

request is made by pressing the vibrator 

push-button. 

Where this is concerned, the EK 533 plus 

2.0  automatically makes a new request 

during red when a request is made during 

green. 
 

Fig. 58 

 

• To guarantee network functionality, all 

networked EK 533 plus 2.0 devices 

must be set to be networked. In addition, 

a number of parameters are 

automatically adjusted when network 

mode is selected: 
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Signal prolongation 
 

• If the box is checked, the signal can be emitted from the corresponding output for as long as 

the respective button (PB/S or VPB) is pressed and held. In other words, this means for longer 

than is indicated under "PB/S (ms)" or "VPB (ms)" respectively. 

• If the box is not checked, the pulse on the output concerned is emitted only for as long as 

specified under "PB/S (ms)" or "VPB (ms)", even when the button (PB/S or VPB) is pressed 

and held. 
 

 
 
 
 

"Feedback" tab 
 
 

• This tab is for configuring optical 

feedback. 

 
General note: 

Optical feedback is triggered by 

• pressing the PB/S or VPB (internally 

produced optical feedback) 

• core 4 (produced by the control unit) 

• or through networking. 
 
 

 

Fig. 60 
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Mode 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
Fig. 61 

 
 
 
 
 
 
 
 
 

Activation 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

Fig. 62 

Determines how optical feedback responds 

after a request: 

• "inactive": No optical feedback. 

• "Flashing 0.5 Hz - 5 Hz": Optical 

feedback takes place at the set flashing 

interval.    Display example: 

"Wait for signal". 

• "Constant light": Optical feedback is a 

constant light. Display example: 

"Wait for signal". 

• "Darkening": Darkening responds in 

exactly the opposite way to the constant 

light. In other words, the starting point is 

a constant light, which then goes out 

when the request is made. Display 

example: "Push button". 

• Determines how optical feedback is 

triggered: 

• "Feedback input": Optical feedback 

activates as soon as there is a signal on 

the feedback input at the level set in 

"Logic type input". 

• Important: Set the mode to constant 
light. 

• "APB": Pressing the PB/S or VPB 

activates optical feedback (caution: APB 

may not be selected when "permanent" 

is selected as the activation input for the 

orientation signal!). 

• "iAPB":  Pressing the PB/S or VPB 

activates optical feedback. This differs 

from the normal APB in that the display 

is inverted. 

• "APBS": Identical to APB, with the 

difference that a signal with the logic 

type entered under "Logic type input" 

must be present for the feedback input 

within the value entered under "Time to 

ack. (s)". Otherwise, the feedback will be 

deactivated. 

 
• "APBI": Can only be used in combination 

with the "Networking" option that can be 
activated under "Outputs". 

 A signal on the feedback input or 

pressing the PB/S or VPB activates 

optical feedback. In turn, this normally 

originates from an output of a networked 

device when "Networking" is in effect 

(see also section "Networking" (Fig. 59 

and Example 4, Page 40). 
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Example 1: 

"Mode" is "Flashing 1 Hz" and activation is "APB": When a button is pressed during the red phase, 

the device starts flashing. It stops flashing when the signal changes to the green phase. 

 
Example 2: 

"Mode" is "Flashing 1 Hz" and activation is "iAPB": When a button is pressed during the red phase, 

the device stops flashing. It starts flashing when the signal changes to the green phase. 

 
Example 3: 

"Mode" is "Flashing 1 Hz", activation is "APBS", "Time to ack. (s)" is "3" and 

"Logic type input" is "high": When a button is pressed during the red phase, the device starts 

flashing. If there is a high level on the feedback input within three seconds, the device goes on 

flashing for as long as that level is sustained. If there is no high level on the feedback input within 

three seconds, the flashing stops after the three seconds have elapsed. The flashing always stops 

when the signal changes to the green phase. 

 
Example 4: 

"Mode" is "Flashing 1 Hz" and activation is "APBI": When a button is pressed during the red 

phase, the device starts flashing. It stops flashing when the signal changes to the green phase. 

The device also starts flashing if there is a signal on the feedback input originating from an output 

of an EK 533 plus connected via networking, for example. 

 
 

 
Time to ack. (s) 

• This determines the time within which the signal system must send the level signal set under 

"Logic type input" in order to keep optical feedback active on the feedback input when the 

"APBS" option is selected under "Activation". 

 
• Restriction: Input is only possible if "APBS" is selected under "Activation". 
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Logic type input 
 

 

• This determines the logic type or level 

which must be on the feedback input in 

order to keep optical feedback active 

when "APBS" is selected under 

"Activation". 

• Restriction: Input is only possible if 

"APBS" is selected under "Activation". 
 
 
 
 

 

Fig. 63 

 
 
 
 
 
 

"Base settings" tab 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 64 

Band stop 1|2|3 (Hz) 

• This determines the frequencies that the 

DSP module ignores when determining 

ambient volume and thus volume 

control. 

• For example, if a polyphonic release 

signal has been defined using an 

880 Hz sine wave, you can also make 

the setting 880 Hz here (and potentially 

also for the inharmonics defined for the 

release signal). Thus, the dynamic 

volume control ignores the release 

signal. 

 
 
 

 

Special function of optional control input 3 

 
With the "Red function" setting, control input 3 (core 14) takes over the function of the red input. 

This allows the orientation signal to be sounded only when actuated by the red phase, for 

example. 

 
General note: Where there is a permanent supply, control input 3's red function is essential for 

green flashing mode. 

With the "Normal" setting, optional control input 3 is used to actuate night-time reduction or night-

time deactivation. 
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"Operating voltage limits" tab 
 
 

• This is where you set the voltage ranges 

for all six inputs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 65 

 
 
 

Loading and saving configurations 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 66 

• EK 533 plus configurations are 

maintained in files with the file ending 

".ek 533p". These contain all settings for 

the device (parameters and sounds). 

• You can transfer existing configuration 

files from the PC to the EK 533 plus. 

• You can create new configuration files 

by reading out an EK 533 plus. 

• To read out the EK 533 plus (save its 

configuration to a file), make the 

following selections: 

• "File" - "Parameter set" - "Read 

(crossguide -> file)". 

• Select and save the required functions. 
• "All"/"Parameters only"/"Sounds only". 

• Enter the desired save location and file 

name in the dialogue box that appears. 

• To transfer existing configuration files to 

an EK 533 plus, make the following 

selections: "File" - "Parameter set" - 

"Write (file - crossguide)". 
• Select the required function. 

•  "All"/"Parameters only"/"Sounds only". 

Note! 

This process overwrites the entire existing 

device configuration (sounds and 

parameters)! 
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Exporting screenshots 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 67 

• The "Export" button in the "Parameters" 

form allows you to produce 

automatically generated screenshots of 

the current parametrisation. 

• After clicking on the button, select the 

directory where you wish to save the 

bitmaps. Screenshots of the tabs 

"Sounds" - "Outputs" - "Feedback" - 

"Base settings" - "Operating voltage 

limits" are then saved. These are 

accompanied by screenshots of the 

"Audio sequences" - "System info" 

forms. 
 
 
 
 
 

Offline parametrisation of the Langmatz EK 533 plus 2.0 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 68 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 69 

• An EK 533 plus 2.0 configuration is 

created in the same way as in online 

mode, except for the fact that you now 

need to select "offline" in the "Edit" menu 

under "Device parameters" for the 
parameters and under "Audio sequences" 

for the sounds. 

 

• The created sounds and parameters can 

be saved locally as described in 

"Creating and editing sound sequences" 

and in "Loading and saving 

configurations". For the parameters, 

make the following selections: 

"File" - "Parameter set" - "Read 

(crossguide -> file)". 

• Likewise, configurations created online 

or offline can be reloaded in offline 

mode ("File" - 

"Parameter set" - "Write (file -> 

crossguide)"). 

 
• If you switch to online mode when 

"Parameters" or the "Audio sequences" 

form is open, you can overwrite the 

displayed offline parameters and offline 

sounds if necessary using the 

EK 533 plus once a connection is 

established. 
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Calling up system information/RTC settings 
 

 

You can call up the following information on 

a connected EK 533 plus using the "Help" -

> "System info" menu: 
 
 
 
 
 
 
 
 
 
 

Fig. 70 

 
 
 

 

• Designation of connected device 

• Firmware version 

• Firmware revision 

• Firmware date 

• By connecting an (optionally available) 

RTC module, you can display the 

temperature of the module and the set 

time. 
 
 
 
 

 
 

Fig. 71 

 
 
 

 

RTC module 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 72 

 
 
 



45  

 
 

If you have an RTC, you can synchronise it 

with the computer if necessary. 

 
• To apply PC time, click the synchronise" 

button. Using the "summer-/wintertime" 

setting, you can tell the RTC whether to 

switch automatically between summer 

time and winter time. 

 
 
 
 

 

Fig. 73 

 
 
 

 

   Note: 

If you have an RTC, cgManager checks at 

regular intervals if the PC time is different 

from the RTC time on the EK 533 plus. If 

the difference is over three minutes, the 

user is asked whether synchronisation is 

required, i.e. whether the RTC time should 

be set to the PC time. 
 
 
 
 

 

Fig. 74 

 
 
 

• You can read out the error memory on a 

connected EK 533 plus 2.0 using the 

"Help" -> "Error Memory" menu. 

• "Refresh" reads out the events and 

errors from the EK 533 plus. 

• The entries can be deleted from the 

device or exported to an Excel sheet. 

• If you have an RTC module, the entries 

are time- and date-stamped. 
 

 

 

 

 

 

Fig. 75 



46  

Application data 
 

• Clicking on the "Application Data" menu opens Windows Explorer and displays the directory 
where cgManager stores program-specific files. 

•  So, for example, this is where you will find the program settings or log files. 

 
• Note! Do not change these files! 

 
 

Level display 
 

 

• The "Level" menu item opens a window 

where you can display the ambient 

volume and frequency spectrum 

measured by the dynamic module (DSP) 

for diagnostics purposes. 
 
 
 
 
 
 
 
 
 
 

Fig. 76 
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Other settings 
 

 

• Using the "Preferences" menu, aside 

from the configuration described in the 

section "Establishing a connection with a 

Langmatz EK 533 plus 2.0", you can 

make the following additional 

adjustments to the interface: 

      "Language" 

You can specify the language 

of cgManager here. 

After changing this setting, you will need 

to restart the program. 
 

Fig. 77 

 
 
 
 

"Firmware-Updates" 

• Here, you can specify how cgManager 

responds to connection issues during 

firmware updates. 

• The figure to the left shows the default 

setting, which does not usually need to 

be changed. 

• If you encounter repeated connection 

time-outs during firmware updates, 

increasing these values may correct the 

problem. 

 

Fig. 78 

 
 
 
 
 

"Offline mode" 

• This dialogue allows you to specify 

which firmware should be parametrised 

in offline mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 79
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Keyboard shortcuts 

 
There are keyboard shortcuts for the most important cgManager functions: 

• Ctrl+P: Open parameters form (online mode) 

• Ctrl+Q: Open parameters form (offline mode) 

• Ctrl+A: Open audio sequences (online mode) 

• Ctrl+B: Open audio sequences (offline mode) 

• Ctrl+C: Open interface selection 

• Ctrl+H: Open system info 

• Ctrl+E: Display error memory 

• Ctrl+W: Close current form 
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9.1 Editing datasets in offline mode 
 
 

• Select item "offline-settings" in the 
"Preferences" menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 80 

 
 
 

• This opens the following window 

(Fig. 87). 

• Checking/unchecking the EK 533 plus 

2.0 box selects whether to edit an 

EK 533 plus ("*.ek533p") or EK 533 

("*.ekg") dataset. 

• The desired hardware must be selected 

for EK 533 datasets. 
 
 
 
 
 
 
 

 
Fig. 81 

 
 
 

 

• In the "Edit" menu, open the "Device 

parameters" and "Audio sequences" 

tables. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 82
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• cgManager appears with empty tables. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig. 83 

 
 
 
 
 
 

• Select the desired parameter set as 

follows: 

- File 

- Parameter set 

- Write (file -> crossguide) 

- All 
 
 
 
 
 

Fig. 84 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 85 

• Depending on the offline settings, you 

can select EK 533 or EK 533 plus 

datasets. 

• The tables are populated. 

• Make the required changes. 
 

 
 
 

 
 
 

• To save changes: 

- File 

- Parameter set 

- Read (crossguide -> file) 

- All 
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9.2 Offline conversion of EK 533 datasets to EK 533 plus 2.0 datasets 
 

 

• Carry out all of the steps in "8.1", Fig. 86 

- Fig. 90. 

• But check the box for EK 533 plus 2.0 

devices. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 86 

 
 

• To save a dataset: 

- File 

- Parameter set 

- Read (crossguide -> file) 

- All 
 
 
 
 
 
 
 
 

Fig. 87 

 
 

• Save as a "*.ek533p" file. 

• The dataset is converted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 88 
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9.3 Online conversion of EK 533 datasets to EK 533 plus 2.0 datasets 
 
 

• Connect the EK 533 to cgManager. 

• Using the "Edit" menu, populate the 

device parameter and audio sequence 

tables. 
 
 
 
 
 
 
 
 
 
 
 

Fig. 89 

 
 
 
 

• To save a dataset: 

- File 

- Parameter set 

- Read (crossguide -> file) 

- All 

 
• Save as a "*.ek533p" file. 

 
• The dataset is converted. 

 
 
 
 

Fig. 90 
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10. Frequently asked questions | cgManager FAQ 

Preliminary note: 

In general, it must always be ensured that the most up-to-date firmware is present on 

the EK533 plus 2.0 device and that the latest version of cgManager is used. Last 

updated: 02 / 24 / 2020 
 

 
 

You can check which versions are installed with cgManager and a connected EK 533 plus 2.0 via 
"Help" -> "System info". 

The version number for cgManager itself is shown in the program title bar. 

The software can be updated online (registration required) at the following address: 

http://langmatz.de/en/service/customer-service/ 

Issue Solution 

cgManager is displaying 

"offline" status 

• Using "Preferences" -> "Interface", check 

that the interface in use is the right one. 

• Ensure that the EK 533 plus connection 
cable is securely connected to the notebook 

and the device. 

 

• If both connections are secure and you are 

using a CrossCom USB cable, you may 

need to reinitialise the interface. To do this, 

close cgManager and remove the cable 

from the notebook. Wait around 5 seconds, 

then reconnect the cable and restart 

cgManager. 

• An "offline" status message can also 

indicate incomplete firmware. If this is the 

case, the firmware can be incorporated 

via "File" -> "Firmware-Update". 

The check box for "Activation" in the "Device 
parameters" form is checked, but no sound 

plays. 

 

• Using "Edit" -> "Audio sequences" -> 
"online", ensure that the sound is present on 

the device. 

 

• Ensure that the "Level max. (dB)" value 

is sufficient. 

• Ensure that the "Elevation (dB)" value is 

sufficient. 

• Ensure that night-time reduction or night-

time deactivation has not been activated 

by mistake. It is possible that the logic 

type is inverted. 

•  

• Check the operating voltage limit 

settings (Fig. 66) 

Element 

Firmware 

cgManager 

Version 

4.8 

4.21.54.0 

http://langmatz.de/en/service/customer-service/
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11.  Accessories | Overview 

 

Remote speaker 
 

• Output:  Output of orientation and/or release 

signal 

(software-configurable) 

• Installation  

height: As per the standard, approx. 2.10 to 2.50 m 

• Installation: Easy installation with a strap fastener or 

screws 

(not included with delivery) 

• Cable length: 3.90 m 

• Alignment: Easy alignment of the speaker with the crossing 

 

• Volume: Can be adjusted using EK 533 with 

"cgManager" configuration software 

• Protection  

class: II (double-insulated) 

• Protection  

rating: IP 64 
 

Order number, version "Release + OT/Green":    12 533 0460/000   
Order number, version "Release/Green":             12 533 0460/010 
Order number, version "Release + OT/Grey":      12 533 0461/000 
Order number, version "Release/Grey":               12 533 0461/010 

 

 

Fig. 91 
 
Acoustic signalling device 
crossguide 

 

 
 
 

 

Remote speaker for triple traffic-light enclosure 

 
•  Output: Output of orientation and/or release signal (can 

be adjusted using software) 
• Cable length: 3.90 m 

• Volume: Can be adjusted using EK 533 with 

"cgManager" configuration software 

• Protection class: II (double-insulated) when installed 

 

• Protection rating: IP 64 when installed, diameter 200 

mm 

 
Order number, version "Release + OT/Black":    12 533 0462/100 
Order number, version "Release/Black":             12 533 0462/110 

 

 

 

 

 

 

 

 

Fig. 92 

 
Variant 2: Acoustic signalling 
device for installation in signal 
chambe
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Communication adapter 
 

Wired communication: 

 

USB parametrisation cable for parametrisation and 
software updating of the EK533. 

 

Langmatz order no.: 125330989S 

 

 

 
 
 
 

 

 

Communication by Bluetooth: 

 

Bluetooth dongle and Bluetooth stick for wireless 
parametrisation of the EK533. 

 

Bluetooth dongle: 

 

An essential solution, e.g. for adjusting the volume from the 
middle of the crossing. 

Also a convenient connection for operating the devices in 

bad weather. 
 

This is plugged into the interface on the outside of the 

EK533 for the duration of parametrisation.  

 

 
 

 
Bluetooth USB stick: 

 

This is used as a counterpart for the Bluetooth dongle. 

 

Bluetooth dongle and Bluetooth USB stick available from 

our partner: 

 

SER Elektronik GmbH 

Zeissweg 6 

D-59519 Möhnesee, Germany 

 

Tel.:  +49 292497 17-0 

Fax:  +49 292497 17-45 

E-mail: info@ser-elektronik.de 

 

Bluetooth dongle order no:  125330998 

Bluetooth USB stick order no: 125330999 

 
 

 

Fig. 94 
Bluetooth dongle 

Fig. 95 
Bluetooth USB stick 

Fig. 93 

USB cable 
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Lighting-pole adaptors (stainless steel) 

 
• Lighting-pole adaptor for large 

poles (diameter of 180 mm - 

300 mm) 

Order no.: 125330992 
• Wall adapter for straight surfaces 

  Order no.: 125330993 

• Universal lighting-pole adapter (up to a 

diameter of 159 mm), suitable for the 

following threaded holes: 

- Langmatz EK 233 

- Langmatz EK 433 (long/short) 

- Wai TB 

- RTB 

- Urich 

- EK 98 

- Kringer 

Order no.: 125330994 

• Large poles, universal (diameter 180 - 

300 mm), 

suitable for the following threaded holes: 

- Langmatz EK 233 

- Langmatz EK 433 (long/short) 

- Wai TB 

- RTB 

- Urich 

- EK 98 

- Kringer 
 Order no.: 125330995 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 96 

"Universal" lighting-pole adaptor 
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Remote control (eee PC) 

 
• Windows 7 

• 2 USB ports 

• Ethernet connection 

• Size: 262 (W) x 178 (D) x 25.9-36.5 (H) mm 

• + Installed cgManager 

• + USB parametrising cable 

• Other versions available on request 

 
 
 

 
 

Fig. 97 

eee PC

 
 

cgManager software 

 
• Compatible with Windows XP/VISTA/Windows 7, 8 and 10 for setting, saving and 

archiving EK 533 plus 2.0 device parameters 

• cgManager download: 

https://langmatz.de/en/service/customer-

service/ Download portal: 

https://kundenportallangmatz.globalconcepts-cloud.de/Login.html
 

 

 

 

Drilling jig 
 

• Attaches to the pole easily with a strap fastener or 

similar (not included with delivery). 

• For convenient drilling of mounting holes for the 

EK 533. 

• Advantages: 

 

- No need to affix drilling template. 

- Drill guided accurately. 

- Drill does not "slip" on the pole. 

- Maintains exact distance 

between holes. 

- Guarantees perfectly aligned button 

installation. 

 

Order no.:   700663003 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

 

 

Fig. 98 

Drilling jig

http://langmatz.de/en/service/customer-service/
http://langmatz.de/en/service/customer-service/
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12. EC Declaration of Conformity 

The product meets the requirements of the following applicable harmonisation directives: 

 

2014/30/EU    Electromagnetic Compatibility (EMC) 

2014/35/EU    Low Voltage Directive (LVD) 

 

The following standards were complied with: 

 

DIN EN 50293:2013 (EMC) 

DIN EN 50556:2019 (LVD) 

DIN       32981:2018-06 

DIN EN 50128:2014 

DIN EN 50129:2019 

 

 

The EU Declaration of Conformity for this product can be requested from Langmatz GmbH. 
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13. Material defects 

Langmatz GmbH accepts liability for material defects in the "Langmatz EK 533 plus 2.0" 

pedestrian signal requesting device as defined in §434 BGB (German Civil Code) for 24 months, 

starting from the date on the purchase receipt. 
Under this liability, all parts damaged by manufacturing faults or material defects 

shall be replaced or repaired free of charge. 

The purchaser must report any deficiency complaints immediately in writing. Claims for 
damages by the purchaser due to material damage or whatever legal reason shall not be 

accepted. 
Our liability does not include any damage or defects caused by 

- improper use, 

- natural wear and tear or 

- the intervention of third parties. 

We accept no liability for damage caused by force majeure or transport. 

 

Repairs due to a deficiency complaint shall not extend the warranty period for the replaced 

parts or the product. 
By choosing the "EK 533 plus 2.0", you have purchased a high-quality product with state-of-the-

art technology. Nevertheless, if you should experience any problems with it, please contact the 

hotline (see reverse). 
 

14. Quality management 
 
Langmatz GmbH's quality management system is certified according to DIN EN ISO 9001. 

 

15. Disclaimers 

The information in this technical document is presented appropriately and correctly according to 

technical regulations and to the best of our knowledge. However, this does not confer any 

guarantee of particular characteristics. The operator of the products supplied by Langmatz GmbH 
is expressly obliged in this context to decide, based on his/her own judgement, whether the 

products are suitable and appropriate for the application or use being considered. The product 

liability pledged by Langmatz GmbH exclusively applies to our conditions of sale, delivery and 
payment. The liability of Langmatz GmbH is excluded in the event of incidental, indirect damage 

and subsequent consequential damage, in addition to damage which is the result of using the 

product for a purpose other than the advertised intended purpose. 
 

16. Contacts 

Langmatz GmbH Am 

Gschwend 10 

82467 Garmisch-Partenkirchen 
Germany 

 
Our hotline: +49 (0)8821 920 137 

Telephone: +49 (0)8821 920-0 

E-mail: info@langmatz.de Internet: 

www.langmatz.de 
 
 
 

file://///S-plunetfile01/plunet01/order/O-2020-00556/!_In/ref/en-gb/info@langmatz.de
http://www.langmatz.de/
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